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This how-to is a comprehensive manual for using the SportsPix XE interface. 

 

SportsPix XE is PC-compatible only and perfect for photographers who need: 

 Volume ordering for teams and group events 

 Easy package set-up 

 Access to VIP pricing 

 Individual orders packaged in windowed envelopes, complete with ID card 

 

Please note: If you currently have an older version of SportsPix, you must uninstall it before 

downloading SportsPix XE. 
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IMPORTANT INFORMATION 

 

 Images need to be in JPEG format and in sRGB colorspace. If sending any black & 

white images, do not send in grayscale – keep as RGB, and desaturate the image. 

 It is recommended that images for SPORTSPIX-XE are stored on your local hard drive 

or external hard drive.  It is NOT recommended to use images directly from a 

removable media such as CD, DVD, card reader or direct camera connection. 

 

Minimum System Requirements 

 

 IBM compatible PC with 2.0GHz Processor or faster 

 Windows XP, Vista or Windows 7 (not compatible with Windows 95, 98, ME or 2000) 

 Min. 512MB RAM (1GB or higher recommended) 

 Min. 10GB free hard drive space 

 High-speed Internet connection to transfer orders 
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THINGS TO KNOW BEFORE GETTING STARTED 

 

SPORTSPIX-XE works by treating each folder of images as an original job order.  Therefore, it 

is important to arrange your images for each job into their own folder on your hard drive.  For 

example, if you store your images under the My Pictures folder in Windows, you may want to 

subdivide the folder by sport or league, and then by team or group of teams.  The name of 

the end folder used will become the name of the order you will send. *Note: The maximum 

length of the image pathname (i.e. C:\Users\John\My Documents\My Pictures\2009 

YMCA\Soccer\ \DSC_0001.jpg) must not exceed 255 characters (including spaces). 

 

When naming your files and folders, it is important not to use any special characters. Below 

are examples of characters that should not be used: 

 

Special characters that should not be used 

! – Exclamation 

Point 
+ - Plus Sign @ - “At” Symbol 

? – Question Mark = - Equals Sign ^ - Hat 

. – Period {} – Brackets & - Ampersand 

, - Comma [] – Square Brackets * - Asterisk 

: - Colon % - Percentage Sign ~ - Tilde 

; - Semi-colon # - Pound Sign ` - Accent 

„ – Apostrophe $ - Dollar Sign / - Forward Slash 

“ – Quotation 

Mark 
() – Parenthesis \ - Backslash 

< - Less than sign > - Greater than sign | - Bar 

 

Acceptable special characters 

- dash/hyphen _  underscore SPACE 

 

If you rename your image files, try to keep the length of the name to 30 characters or less. 

Only one original order can be placed per folder name, but you can place multiple reorders by 

using the Place A Reorder option in SPORTSPIX-XE,. 
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FIRST TIME USERS 

 

When you first use SPORTSPIX-XE, you will 

need to set the data path for storing 

orders.  The data path stores your order 

details and should not be used for storing 

images.  In most cases it is best to create 

a new folder on your C:\ drive purely for 

SPORTSPIX-XE orders.   

 

To set the data path click Edit on the main 

screen and select Set Path For Storing 

Orders.  Select the drive and folder you 

wish to use or click Make New Folder to 

make a new folder for your order data on 

the selected drive, or just select an existing folder. 

 

64-bit Windows 7 or Vista users may want to create a 

new folder under the User folder, such as: 

“C:\Users\Chris\SportsPix-XE”, for installation of the 

software.  This will help with a Windows security feature 

that tries to move & hide certain file types used by 

SportsPix, causing files to become lost. 
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Next, you will need to enter your Customer 

Information.  On the main screen, click Edit, and 

select Edit Customer Information.  Be sure to fill 

in all fields including the credit/debit card 

information.  If you wish, an option is provided to 

password protect your card information.  This is 

useful if multiple people enter orders on the 

computer and you wish to limit who can see this 

sensitive information.  If you forget this password, 

simply click the button marked Reset Password & 

Clear CC Info.  This will clear out all credit card 

data and allow it to be re-entered and a new 

password created.  As a security precaution you 

will not be asked for your three-digit security code 

until you send an order.  If you do not wish to do 

this on every order, click Store CSC Number 

under the Edit menu to keep the code in memory. 

 

   

 

Once all information is entered, click Exit 

to complete this step. 

 

Note: This step can be completed once your first order has been completed.  But, before the 

order can be sent, you will be prompted to fill out this screen to continue. 
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STARTING AN ORDER 

 

Before starting a new order, you‟ll need to decide if you want to use the Express Cropping 

option or if you want to crop each image individually.  The Express Cropping option is 

discussed in detail in Step 2: Cropping.   

 

To begin a new order click File and then select either Begin New Order or Begin New Express 

Order.   

 

   

 

A screen will appear for you to select the folder of images to be used in this order.  You can 

either drag the folder of images into the yellow box, or you can navigate to the desired folder.  

The image path will be displayed, and if correct, click OK.  A dialog box will appear verifying 

the total number of JPEG images in the folder.  The “Groups” folder mentioned is used with 

Express Cropping only and is explained further in Step 2: Cropping.  If you‟re not using the 

Express Cropping option, disregard this portion of the message. 
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If the number of images is correct, click Yes to proceed to the next screen.  If you click No, 

you will be taken back to the main menu so that you may either correct the number of 

images or select a new folder. 

 

STEP 1: DEFINE YOUR PACKAGES 

 

On the Define Your Packages screen you will build your packages as offered to your 

customers on your order form.  You can create up to 26 packages (A-Z) containing from 1 to 

8 different items in each.  In addition, you may also add up to four different a la carte items 

per frame for an Individual. 

 

Building your packages is as simple as clicking on an item from the list of products, then 

clicking on the drop-down to select the quantity needed for one package.  Items such as 

wallets, traders and magnets will be listed in multiple quantities as offered in our catalog. 

 

 

To remove an item from a package, double-click on the package item and it will be erased 

from that package. 

 

To move to the next package letter or to navigate between packages, use the Next Package 

& Previous Package buttons. 

 

VIP PRICING 

VIP Pricing is a special pricing system that allows the photographer to take advantage of 

15%-75% discounts on a wide range of our most popular products.  Whenever a customer 
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orders a package containing one of our 52 pre-designed Lab Packs, any additional items 

added to a package or sold as an add-on, will be sold at a discounted rate.  Lab Packs cost 

$4 and are built around the most popular packages used by photographers.  The discounted 

add-on items are be arranged into $1, $3, $6 & $10 price tiers. 

 

To qualify for VIP Pricing, you will need to include a Lab Pack in at least one of your packages, 

and only frames that order one of these packages will be eligible for the discounted rates. 

 

To help you in building your packages, you can click on Pricing Information on the menu bar 

for a list of Lab Packs, add-on items, and regular pricing.  When selected, these screens will 

stay open for your convenience while creating your order. 

 

Once all packages have been entered you may wish to save the packages as a default work 

order.  Click Save Default Work Order and then enter the name for the default work order.  

There is no limit to the number of default package layouts that can be stored, but each 

default must have a unique file name.  To use a previously saved default package layout, 

click Import Default Work Order, and select the desired saved default.  You can save & 

import defaults at any time in the order process. 

 

To proceed to the next section click Step 2: Cropping. 

 

STEP 2: CROPPING 

 

In order for your images to be printed correctly on the products, you will need to rotate all of 

your images so the heads are up.  By clicking on Rotate, the image will be rotated in 90° 

increments.  If most, or all, images need to be rotated by the same amount for each frame, 

checking the Hold Rotation box will automatically rotate each image by the same amount 

each time you click Next. 

 

If you need to print from two different orientations or crops of the same image, you can click 

Copy Image to create a duplicate image.  This image will have a sequential number added at 

the end of the filename which, in most cases, will cause the two images to appear next to 

each other in sequence.  This ability is very useful if you wish to print a horizontal print of an 

individual on a 5x7, but need to also order a product such as traders that require a vertical 

crop.(If using a copy image, VIP Pricing will not apply unless both images order a Lab Pack). 
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Next, click on the checkbox for the image type – Individual or Group.  Please remember, if 

ordering Pro Products such as composites or traders, your individuals should be shot vertical 

and your groups should be shot horizontal. 

 

Drag the crop box to set the crop position for your image.  Use the Zoom slider to make the 

crop box smaller for a tighter crop. 

 

The RED box shows what will print for any product that uses a 5x7 crop. 

The BLUE box shows what will print for any product that uses an 8x10 crop. 

The GREEN circle shows what will print on a button. 
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The outer crop box will default to the closest crop to the original aspect ratio of your image.  

To change the outer crop box click the Swap Primary Crop checkbox.  You may also change 

the orientation of the crop box by clicking on the Change Crop Orientation checkbox. 

 

Click the Next button to proceed to the next image, and repeat the same process for all 

images in the order.  SPORTSPIX-XE will remember the crop size and image type from frame 

to frame, so if you have a large number of images that are of the same type and do not need 

to be re-cropped, you may simply keep clicking on Next until a change in crop or image type 

is needed. 

 

Using Express Cropping  

Express Cropping speeds up the ordering process by automating the Cropping step of 

SportsPix.   

 

*** All images will be cropped full-frame from the center, so be sure that your images have 

adequate space for all crop sizes, as no adjustments will be made at the lab. *** 

 

Make sure all images are rotated “heads-up”. 

Make a sub-folder in your image folder named Groups. 

Move all of your group images into the Groups sub-folder. 

Begin your new order by selecting Begin New Express Order from the File menu. 

When you get to “Step 2: Cropping” you can still make individual adjustments as needed, or 

simply jump to Step 3. 

 

By using this feature, the photographer takes responsibility for correct cropping. 

 

Once you have reached the last image in the folder, clicking Step 3: Order Data will take you 

to the Data Entry screen for the first image in the order. 
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STEP 3: ORDER DATA 

 

Data entry screens for your images are broken down into two types – Groups and Individuals. 

SportsPix-XE will show all Groups before the Individuals. 

 

 

 

 

Start by entering a unique Group/Identifier for the image (max. length is 13 characters).  The 

Group/Identifier links your individuals to the correct group image.  This means that the 

correct image, information, and designs will be used for products.  Each Group/Identifier 

needs to be unique, but the name printed on Pro Products (items using the trader design) 

can be different from the Group/Identifier and can even be the same for each group, if 

needed. 

If you do not want the group name printed on Pro Products, make the first character of your 

Group/Identifier a “–“, (dash).  Existing Group/Identifiers are listed in the drop-down box.   

 

The yellow box at the top of the screen will show exactly what will print on Pro Products as 

you type it.  Check that this is correct before proceeding. 

 

If you need extra team prints for coaches, sponsors etc., these can be selected from the 

drop-down list marked Available Products to Order.  Once you select an item, use the drop-

down list to select the quantity needed.  You can double-click on an item to delete it.  For 
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greater value on extra group prints, you can order Team Packs, which give you a discounted 

rate on packs of group prints.  

 

On the right side of the screen you will see a section to enter text for other group products 

such as Team Graphics, Overlays, Sports Composites, and Team Calendars.  Click the “+” 

sign next to the product for which you wish to add text.  You only need to fill out the 

information for the products you are ordering for this group. 

 

If you wish to use the same information on all of your groups, click the Copy to all Others 

button, and the information for this product will be transferred to all groups on the order.  In 

addition to this ability, you may also copy information from any other group in the order by 

selecting the group name from the drop-down list marked Transfer Information From Existing 

Group To This One.   

 

Once you have finished entering text for a particular group product, click the “-“ (minus sign) 

sign to close the text box and move on to another group product.  If the wording for a group 

product is displayed in white, no information has been entered for that product.  The product 

name will turn darker gray once information has been added. 

 

Once you have completed the information for an image, click Next to go to the next image. 

 

If the next image is an individual, the data entry screen will appear as below: 
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To order packages for an individual, either type the letter of the first package you want to 

enter, or click on the drop-down marked Package. Next, type the quantity of the package 

needed, or select it from the drop-down list.  Repeat this for as many different packages as 

the individual needs (max. four different packages per frame).  In addition, you may select up 

to four different a la carte items per frame.  To do this, click on the drop-down list marked A 

la Carte and select the item needed, then use the quantity drop-down to select the quantity 

of the item needed. 

 

Select the appropriate Group/Identifier from the drop-down list. If there is no group image for 

this frame, you can create a group name for this individual to print on Pro Products. 

 

If you order a package that includes Pro Products, text fields will open up on the bottom 

portion of the screen to allow for personalized information to be entered, such as the 

individual‟s name, trader stats, etc.  For the trader stats of Position, Age, Height, Weight and 

Jersey #, you may enter the standard information, or you may customize these lines for 

special info such as the coach‟s name or hometown.  The customized text fields can 

accommodate up to 30 characters per line. 

 

Three new buttons have been added to speed up the data entry process for some orders: 

 

Apply Same Group Identifier to All Individuals – if all individuals are on the same group/team, 

this button will apply the selected Group/Identifier to all individuals. 

 

Apply Same Group Identifier to All Individuals without a Group Identifier – similar to the first 

button, this will apply the selected Group/Identifier to all frames without an identifier. 

 

Apply Same Packages to all Individuals – If all individuals are ordering the same item or 

package, the selected items will be copied to all individual frames. 

 

Once you have completed all the necessary data for this image, click Next to proceed to the 

next frame. You may also click the Step 4: Designs button to proceed to the next step. 

 

Work on Existing Order/Reorder 

 

SPORTSPIX-XE will save your order as you step from frame-to-frame, but in cases where 

you‟ve begun an order but are unable to complete it in one session, you may click File, and 

select Save and Exit.  To return to ordering, click File on the Main Menu and select either 

Work on Existing Order or Work on Existing Reorder depending on the order type you were 
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working on.  You‟ll be prompted to pick the original order or reorder you want to reopen and 

then select the screen or step you‟d like to jump to.  You can then continue your order as 

normal. 

 

STEP 4: DESIGNS 

 

On the Designs screen you will identify which product designs you want for each group on the 

order.  You may also select additional options such as metallic paper and overlay text colors. 

 

 

 

Copy These Designs To All Groups – Check this box to copy your selected designs to all 

groups on the order.  You need to select all the designs needed before clicking this option. If 

you have only one team on this order, you will not see this option. 

 

Print Entire Order on Metallic Paper – Select this option to have all products printed on 

metallic finish paper.  The default paper type is Kodak E-surface paper.  You may only use 

one paper type per order. 

 

Pro Design Year, Pro Button Design, Magazine Cover Design, Pro/Elite Design, & Stadium 

Design – This is where you select design and year choices for personalized Pro Products such 

as traders, buttons, magnets and stadium tickets for the current group. 



 

SportsPix XE Detailed How-To Manual 

 

 15 

 

Information For Groups – Here you will select your year and design choices for Team 

Graphics and Composites. 

 

Overlay Colors For Group Prints – If ordering a text overlay for your groups, you may select 

one of nine colors for the text.  In addition, you may also select a banner background color 

and a banner stroke color to go behind the overlay text.  For an example of banner overlays, 

please visit our web site. 

 

Banner Overlay Colors For Individual Prints – By checking the Apply Banner Text to all 

individuals with this Group ID box, you can choose to print the individual‟s name, the 

Group/Identifier (or Name on Pro Products), and the Pro Year on all of the regular individual 

print sizes.  If ordering banner text, you may select one of nine colors for the text.  In addition, 

you may also select a banner background color and a banner stroke color to go behind the 

overlay text.  For an example of banner overlays, please visit our web site. 

 

Calendar Info – If ordering a calendar on this group, select the month in which you wish the 

calendar date to start and the year or years to print. 

 

Design Theme – Using Design Themes allows you to quickly & easily choose matching 

designs & colors for a group, without having to look up design codes for each different 

product in your order.  We currently have five generic Design Themes: High Impact, Need for 

Speed, Scorched, Victory Lap, & After Class.  These Design Themes are available in a choice 

of eight colors (except Scorched):  Blue, Red, Green, Purple, Orange, Black, Maroon, & Gold. 

 

Click on the checkbox that says, “Use a Design Theme for this Group”. 

Select a Theme from the drop-down box. 

Select a color. 

 

Note:  You will still need to select a Pro Year, Group Year, Calendar Information, & Overlay 

Color for products, but you will see that the other design options are grayed out. 

 

Upload My Images To SeeMyPrints – Checking this box allows images to be uploaded to 

www.seemyprints.com for online ordering of standard prints such as 8x10‟s, 5x7‟s and 

wallets etc.  your e-mail address must match for both the BRI and SMP logins. Please see 

either the BRI or SMP web sites for additional information. 

 

Once you have entered information for all frames, click Step 5: Shipping to proceed to the 

next step. 

http://www.seemyprints.com/
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STEP 5: SHIPPING 

 

  

 

The Shipping screen has several options for you to wrap up your order.   

 

Shipping Methods - Normal shipping is free for all orders over $10.  For orders under $10, a 

$3.95 shipping/handling fee will be applied.  For 1 or 2 day shipping upgrades, additional 

charges will apply based on weight and zone, and this will be calculated when the order ships 

from the lab.   

 

Drop Ship Information - Drop shipping will have the entire order shipped to your client rather 

than your studio.  To use this option, fill in the name and address for your client and click the 
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button that says Click to Confirm Drop Ship.  If you enter an incorrect address or simply 

change your mind, click the Remove Drop Ship button.  Drop ship recipients will not receive 

an invoice with lab costs; they will have a packing slip only.  If you do not choose the drop 

ship option, the order automatically ships to you based on the address information stored on 

your account.  To review or edit this information, log in at www.blackriverimaging.com and 

choose the My Account option at the top and then the Modify Profile option on the left side.  

 

Customer Service Notes – Use this area to sned information or special instructions to 

Customer Service. Please be aware that these notes don‟t halt production of your order, so if 

you have a question, it is recommended that you contact Customer Service before 

completing the order.  

 

Promotional Code - This is used for special promotions or remake codes. In the event of an 

error or problem with an order, you may be issued a remake code by Customer Service to 

enter in this box.  When used, be sure to click the Save Code button.  The code will be 

processed with the order information and you‟ll see the price reduction reflected in total in 

your email confirmation. 

 

When you‟ve completed the necessary information, click Step 6: Error Check 

 

 

http://www.blackriverimaging.com/
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STEP 6: ERROR CHECK 

 

 

 
 

At this stage you will run an error check on the order to look for missing information or 

potential problems with the order.  Click Run Error Check to begin the process and wait a few 

seconds for the result.  If errors are found they will be highlighted in red in the list.  You may 

click on the item to go to the appropriate screen to correct the item.  Note: An order cannot 

be sent until all errors have been corrected. 

 

Please note: Error check DOES NOT look for spelling errors, incorrect group assignments, 

cropping issues or missing overlay text. 
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STEP 7: VIEW REPORTS 

 

 

 

If you wish to view a report of your completed order, click Reports on the either the Run Error 

Check screen or the Main Menu, then select the order you wish to view.  Reports may be 

either printed or previewed on the screen. 
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SENDING AN ORDER 

 

Once the Error Check is successfully completed, you will be asked if you are ready to send 

your order.  Clicking Yes will begin transmission of your order to the lab. 

If you are on the Main menu, go to Tools and select Upload An Order.   You will be prompted 

to select the order you wish to send from a list of existing orders.  Double-click the completed 

order and you will be prompted to enter the 3 or 4-digit security code from the credit/debit 

card being used.  Once this has been input your order should start to send to the lab  
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PLACING A REORDER 

 

If you wish to place a reorder from a previous order, this can now be done directly through 

the SPORTSPIX-XE software. 

 

 

 

 

Go to the File menu on the main screen and select Place A Reorder.  You will be prompted to 

select the original order on which to base the reorder.  Once a job is highlighted, click Open 

to begin your reorder.  All defined packages will remain intact on the work order screen, as 

will all group names and personalized information on the data entry screens.  Crop position 

will also be remembered from the original order.  All you need to do is navigate to the group 

or individual you want to order and select the item or package you wish to reorder.  Once this 

is done for all frames needed, simply send the order as normal. 

 

All images must still be in the same location on your computer as they were for the original 

order otherwise you will not be able to use the Place a Reorder option. 
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TOOLS MENU 

 

 

 

Although not frequently used, the Tools menu provides some handy shortcuts to SPORTSPIX-

XE functions & utilities without having to open an order. 

 

Add Customer Service Notes 

Update Shipping Information 

Run Error Check 

Upload An Order 

Upload Missing File – In certain cases where a file may not have transferred correctly, you 

may be asked by Customer Service to transfer the missing file using this utility. 

Update Prices & Designs – Occasionally, it may be necessary to ruin this utility to import new 

designs, products or pricing into the software. 

Get Order Number – Used to retrieve the order number for orders sent to the lab. 

 

 

 

If you require further assistance using SPORTSPIX-XE, please contact Black River Imaging 

customer service at 1-888-321-4665 or by e-mail at custserv@blackriverimaging.com 

 

 

mailto:custserv@blackriverimaging.com

